VGSM-120

GSM/GPRS Alarm Communicator

Visonic
<table>
<thead>
<tr>
<th>N.</th>
<th>Description</th>
<th>N.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>GSM Antenna</td>
<td>12</td>
<td>Metal base</td>
</tr>
<tr>
<td>2</td>
<td>Magnetic base</td>
<td>13</td>
<td>Cover</td>
</tr>
<tr>
<td>3</td>
<td>Antenna cable</td>
<td>14</td>
<td>Base fixing holes</td>
</tr>
<tr>
<td>4</td>
<td>Connector SMA for GSM Antenna</td>
<td>15</td>
<td>Tamper switch fixing pins</td>
</tr>
<tr>
<td>5</td>
<td>Status LEDs</td>
<td>16</td>
<td>Tamper switch fixing nuts</td>
</tr>
<tr>
<td>6</td>
<td>SIM holder</td>
<td>17</td>
<td>Cable feed opening on the base</td>
</tr>
<tr>
<td>7</td>
<td>P.C.B. fixing holes</td>
<td>18</td>
<td>Antenna wire feed opening on the base</td>
</tr>
<tr>
<td>8</td>
<td>Cable connector for programming via PC</td>
<td>19</td>
<td>Cover fixing holes</td>
</tr>
<tr>
<td>9</td>
<td>Terminal Blocks</td>
<td>20</td>
<td>Cover fixing screws</td>
</tr>
<tr>
<td>10</td>
<td>Tamper switch (optional)</td>
<td>21</td>
<td>Cable clamp tab</td>
</tr>
<tr>
<td>11</td>
<td>P.C.B. support</td>
<td>22</td>
<td>Holes for the insertion of P.C.B. supports</td>
</tr>
</tbody>
</table>

![Fig. 1 - Parts](image-url)
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPLIANCE WITH STANDARDS</td>
<td>4</td>
</tr>
<tr>
<td>Recycling information</td>
<td>4</td>
</tr>
<tr>
<td>1. INTRODUCTION</td>
<td>5</td>
</tr>
<tr>
<td>Features</td>
<td>5</td>
</tr>
<tr>
<td>Technical Specifications</td>
<td>5</td>
</tr>
<tr>
<td>Description</td>
<td>6</td>
</tr>
<tr>
<td>Identification of Parts</td>
<td>6</td>
</tr>
<tr>
<td>2. INSTALLING THE DEVICE</td>
<td>7</td>
</tr>
<tr>
<td>ANT-EU Remote Antenna</td>
<td>7</td>
</tr>
<tr>
<td>3. CONNECTING THE DEVICE</td>
<td>8</td>
</tr>
<tr>
<td>Auxiliary connections</td>
<td>9</td>
</tr>
<tr>
<td>4. STATUS LEDS</td>
<td>10</td>
</tr>
<tr>
<td>5. OPERATING PRINCIPLES</td>
<td>12</td>
</tr>
<tr>
<td>Restore default programming</td>
<td>12</td>
</tr>
<tr>
<td>PSTN pre-set channel</td>
<td>12</td>
</tr>
<tr>
<td>GSM pre-set channel</td>
<td>13</td>
</tr>
<tr>
<td>Contact ID transmission sequence on GPRS</td>
<td>13</td>
</tr>
<tr>
<td>SMS dialer</td>
<td>13</td>
</tr>
<tr>
<td>Voice dialer</td>
<td>14</td>
</tr>
<tr>
<td>Priority management</td>
<td>15</td>
</tr>
<tr>
<td>Simulated telephone line priority</td>
<td>15</td>
</tr>
<tr>
<td>SMS dialer priority</td>
<td>15</td>
</tr>
<tr>
<td>Dialer event priority</td>
<td>15</td>
</tr>
<tr>
<td>PayAsYouGoBalance</td>
<td>15</td>
</tr>
<tr>
<td>(PTM) monitoring of communication with the control unit</td>
<td>15</td>
</tr>
<tr>
<td>6. ACTIVATING THE OUTPUTS</td>
<td>16</td>
</tr>
<tr>
<td>Activating/Deactivating Automatic Outputs</td>
<td>16</td>
</tr>
<tr>
<td>Monostable Outputs</td>
<td>16</td>
</tr>
<tr>
<td>SMS</td>
<td>17</td>
</tr>
<tr>
<td>Caller Identification</td>
<td>17</td>
</tr>
<tr>
<td>7. REMOTE PROGRAMMING BY SMS MESSAGE</td>
<td>18</td>
</tr>
<tr>
<td>Changing the user code</td>
<td>18</td>
</tr>
<tr>
<td>Enabling or disabling remote programming</td>
<td>18</td>
</tr>
<tr>
<td>Changing the Installer code</td>
<td>18</td>
</tr>
<tr>
<td>Credit balance check</td>
<td>18</td>
</tr>
<tr>
<td>8. PROGRAMMING VIA PC</td>
<td>19</td>
</tr>
<tr>
<td>Viewing the Device Settings</td>
<td>19</td>
</tr>
<tr>
<td>Downloading the Device Settings</td>
<td>19</td>
</tr>
<tr>
<td>Preliminary operations</td>
<td>19</td>
</tr>
<tr>
<td>Phonebook</td>
<td>21</td>
</tr>
<tr>
<td>Options</td>
<td>21</td>
</tr>
<tr>
<td>Dial options</td>
<td>21</td>
</tr>
<tr>
<td>Event priority</td>
<td>22</td>
</tr>
<tr>
<td>Codes</td>
<td>22</td>
</tr>
<tr>
<td>Generic</td>
<td>22</td>
</tr>
<tr>
<td>System</td>
<td>22</td>
</tr>
<tr>
<td>Pay As You Go</td>
<td>23</td>
</tr>
<tr>
<td>Primary Path</td>
<td>23</td>
</tr>
<tr>
<td>GPRS</td>
<td>23</td>
</tr>
<tr>
<td>Access Point Name 1 and Access Point Name 2</td>
<td>23</td>
</tr>
<tr>
<td>Main Receiver, Local Port 1 and Alarm Port 1 IP address</td>
<td>23</td>
</tr>
<tr>
<td>Backup Receiver, Local Port 2 and Alarm Port 2 IP address</td>
<td>23</td>
</tr>
<tr>
<td>APN1 Username and Password, APN2 Username and Password</td>
<td>24</td>
</tr>
<tr>
<td>Telephone numbers to decode</td>
<td>24</td>
</tr>
<tr>
<td>DNIS</td>
<td>24</td>
</tr>
<tr>
<td>Account code</td>
<td>24</td>
</tr>
<tr>
<td>Enable Supervision</td>
<td>24</td>
</tr>
<tr>
<td>Supervision time (sec)</td>
<td>24</td>
</tr>
<tr>
<td>Status</td>
<td>24</td>
</tr>
<tr>
<td>Status section</td>
<td>24</td>
</tr>
<tr>
<td>PTM</td>
<td>25</td>
</tr>
<tr>
<td>I/O</td>
<td>25</td>
</tr>
<tr>
<td>Voice Dialer</td>
<td>27</td>
</tr>
<tr>
<td>Local Service Mode</td>
<td>26</td>
</tr>
<tr>
<td>SMS dialer</td>
<td>28</td>
</tr>
<tr>
<td>Periodic SMS</td>
<td>28</td>
</tr>
<tr>
<td>Voice Message</td>
<td>29</td>
</tr>
<tr>
<td>Local Voice Message Recording</td>
<td>29</td>
</tr>
<tr>
<td>Local Voice Message Replaying</td>
<td>29</td>
</tr>
<tr>
<td>Optional Tamper Programming</td>
<td>30</td>
</tr>
</tbody>
</table>
COMPLIANCE WITH STANDARDS

Hereby, Visonic declares that the VGSM-120 is in compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC. The complete R&TTE Declaration of Conformity for each Device can be found at www.visonic.com.

Installation of these systems must be carried out strictly in accordance with the instructions described in this manual, and in compliance with the local laws and bylaws in force. The above mentioned VGSM-120 has been designed and made to the highest standards of quality and performance. The manufacturer recommends that the installed system should be completely tested at least once a month.

VISONIC Ltd shall not be responsible for damage arising from improper installation or maintenance by unauthorized personnel.

VISONIC Ltd reserves the right to change the technical specifications of this product without prior notice.

Recycling information

VISONIC recommends that customers dispose of their used equipment (panels, detectors, sirens, and other devices) in an environmentally sound manner. Potential methods include reuse of parts or whole products and recycling of products, components, and/or materials.

For specific information see http://www.visonic.com.

<table>
<thead>
<tr>
<th>Waste Electrical and Electronic Equipment (WEEE) Directive</th>
</tr>
</thead>
<tbody>
<tr>
<td>In the European Union, this label indicates that this product should NOT be disposed of with household waste. It should be deposited at an appropriate facility to enable recovery and recycling.</td>
</tr>
</tbody>
</table>

For specific information see http://www.visonic.com

To program this device use the software VGSM-120 Console ver. 3.0 or higher.
1. INTRODUCTION
The VGSM-120 is GSM a communicator which, in the absence of a PSTN line, transmit vocal and digital alarms to Sur-Gard System III and System II receivers, via GPRS.
The VGSM-120 includes GSM/GPRS communicator electronic card, antenna with 25 cm cable and casing. This manual provides programming and operation of the GSM/GPRS alarm Communicator. If there are any special installation requirements, the remote ANT-EU outdoor antenna may be used.

Note: This Communicator is fixed and shall be installed by Service Persons only (service person is defined as a person having the appropriate technical training and experience necessary to be aware of hazards to which that person may be exposed in performing a task and of measures to minimize the risks to that person or other persons). It shall be installed and used within an environment that provides the pollution degree max 2, over voltages category II, in non-hazardous, indoor locations only. This manual shall be used with the Installation Manual of the alarm control panel. All instructions specified within that manual must be observed.

Features
- Simulates land line
- Switches automatically to GSM Network in the event of land line trouble (line down)
- Manages and signals Incoming/Outgoing calls
- GSM signal indicator
- 3 programmable terminals as Open Collector Outputs or Input Lines
- Land line overvoltage protection
- GSM Quad-Band
- Antenna with magnetic base
- SMS dialer
- Voice dialer
- Supports Contact ID communication format from a connected control panel for communication over the GPRS network
- GPRS/Internet communication with receivers Sur-Gard System III / II

Technical Specifications
The input voltage to this can be drawn from the Control Panel.

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Voltage</td>
<td>between 10 and 27.6 VDC</td>
</tr>
<tr>
<td>Standby current</td>
<td>100 mA maximum (not including the outputs) at 13.8 Vdc</td>
</tr>
<tr>
<td>Maximum alarm (Transmitting) current</td>
<td>250 mA average (not including the outputs) at 13.8 Vdc</td>
</tr>
<tr>
<td>Outputs</td>
<td>3 open collector, 100 mA</td>
</tr>
<tr>
<td>Operating frequency</td>
<td>900/1800 MHz or 850/1900 MHz</td>
</tr>
<tr>
<td>Maximum loop resistance of line between the device connected in series on LI</td>
<td>1 K ohm</td>
</tr>
<tr>
<td>Maximum number of parallel devices connected on LI</td>
<td>1</td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>5 to 40 °C / 41 to 104 °F</td>
</tr>
<tr>
<td>Dimensions (WxHxD)</td>
<td>90x190x75 mm (without antenna)</td>
</tr>
<tr>
<td>Weight</td>
<td>348 g</td>
</tr>
</tbody>
</table>
Description

This Communicator manages SMS and Central Station transmissions and can simulate the land line in the event of trouble (land line down) or even substitute the land line completely in areas where the GSM service is provided and where the land line is not available. It has capability of communicating alarm signals via the GPRS data network. This capability enables a fast reliable path to central stations equipped with a Sur-Gard System III or System II receiver. The performance of this Communicator depends greatly on GSM Network coverage, therefore, it should not be mounted without first performing placement tests of the antenna to determine the best location for reception (at least 1 green LED should remain lit). The VGSM-120 Communicator has 3 terminals which can be programmed as follows:

- Outputs (default setting) which can be activated/deactivated remotely, or used to provide status indications (problems on the PSTN telephone line; problems on the GSM network; Supervision Message Missing; Fail To Communicate).
- Input lines for speech dialer and SMS dialer activation; these functions can also be used to transmit status indications. Due to the characteristics of GSM Networks, this Communicator can activate only as intended and cannot be used as a modem for fax/data transmissions or for teleservice operations.

Identification of Parts

The numbers in square brackets [ ] in this manual refer to the main parts of this Communicator (see Fig. 1) described in this section.
2. INSTALLING THE DEVICE
(SEE FIG. 1)

Notes:  Do not route any wiring over circuit boards.
This Communicator shall be installed by qualified SERVICE PERSONS only, in the shelter of a
safe and dry site, away from radio-transmitting equipment.
Test the GSM Network reception before mounting this Communicator in the proposed placement.

2. Drill holes in the wall as marked.
3. Insert the 4 PCB supports [16] into the holes on the metal base [27].
4. Feed the connection cables through the opening on the base [22].
5. Fix the metal base to the wall using wall anchors (not supplied).

Caution! Make sure you do not damage wiring or pipes in the chase.

6. Position the electronic P.C.B. on the supports [16] and push it down until it clicks into position, as
illustrated in Figure 1.
8. Feed the antenna cable [3] the cable clamp tab [26], then through the opening [23].
9. Position the antenna [1] on the upper edge of the base so that the magnetic base [2] adheres to the
surface.

Note:  The antenna may be positioned on the top edge of the base, at the point most suited to receiving
the GSM signal.

10. If necessary, fit the MAXIASNC anti-tamper switch [15] (optional) to the pins as illustrated in Figure 1.

Note:  The switch lever must be directed as illustrated in Figure 1, otherwise the device will not work
correctly.

11. Perform the terminal block connections [10] as described in par. "Connecting the device" and, if necessary,
connect the anti-tamper switch (for connecting the tamper switch see the "Connecting the device-
>Auxiliary connections" section).

12. Following the arrow, insert the SIM-CARD [8] face down in the SIM holder [6] (see Figure 1).

CAUTION! The SIM-CARD PIN must be disabled before the card is inserted into the Communicator.

CAUTION! It is recommended that you disable call forwarding on your SIM card.

13. Make sure that all the green LEDs flash when the product is switched on; this means the Communicator
is in its initialization phase.

14. Checking Signal Strength:
   - Make sure that at least one of the green LEDs remains lit; all green LEDs lit indicates optimal
     coverage;
   - If the green LEDs are not illuminated, the signal strength is TOO WEAK; for the signal to be of an
     acceptable level, at least one green LED must be lit.

15. Close the communicator: fasten the lower side of the cover [18] to the base [17] then press the upper edge
of the base to close the cover; fix the cover in place using screws [25].

CAUTION! Connect power circuit and the telephone line only after the cabinet has been secured to the
building or structure and has been connected to the protective earth ground of the building.

CAUTION! Before inserting or removing the SIM card, please ensure the unit is powered down.

ANT-EU Remote Antenna
For details of how to fit the remote ANT-EU outdoor antenna, please refer to the instructions supplied with
the product. The ANT-EU is used to provide the Communicator with excellent GSM signal strength.
## 3. CONNECTING THE DEVICE

This section describes the terminals and auxiliary connections. Figure 2 shows a typical wiring diagram.

<table>
<thead>
<tr>
<th>N.</th>
<th>Ter.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+V</td>
<td>Power supplied by the control unit, at a level between 10 and 27.6V dc, make sure that this is protected and operating at a limited current; Limited Power Source (LPS) in conformity with EN 60950-1:2006 standard. <strong>CAUTION!</strong> To connect the supply use wires with a maximum 2 m length and 0.75 mm² cross-section. For shorter wires use suitable cross-sections.</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Negative: Power supply and shared terminal for the Open Collector outputs.</td>
</tr>
<tr>
<td>3</td>
<td>T1</td>
<td><strong>Programmable terminals:</strong> These terminals can be programmed as follow.</td>
</tr>
<tr>
<td>4</td>
<td>T2</td>
<td>• <strong>Open collector outputs (default setting):</strong> These outputs may be activated either by programmed events (automatic activation), or by a command sent via SMS, or through caller recognition (remote activation); please refer to the &quot;Output activation&quot; section for further information. The maximum current available at each OC output is 100 mA.</td>
</tr>
<tr>
<td>5</td>
<td>T3</td>
<td>• <strong>Input lines:</strong> When these inputs receive alarm signals, they can activate the SMS and telephone dialer functions (please refer to the &quot;SMS dialer&quot; and &quot;Voice dialer&quot; sections).</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td><strong>Earth Ground:</strong> This terminal must be connected to the Mains Earth, in order to comply with the Telecommunications Network Safety Standards (Overvoltage Protection Requirements).</td>
</tr>
<tr>
<td>7</td>
<td>LE</td>
<td><strong>External telephone line:</strong> These terminals can be connected to the land line.</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>LI</td>
<td><strong>Internal telephone line:</strong> These terminals must be connected to the control panel or an alternative communication terminal.</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The Open Collector current may not exceed 100 mA. If necessary, commutate greater loads using switches.

**CAUTION!** Incorrect connections may result in FTC fault or improper operation. Inspect wiring and ensure connections are correct before applying power. DO NOT route any wiring over circuit boards; maintain at least 1” (24.5 mm) separation. A minimum 1/4” (6.4 mm) separation must be maintained at all points between Power Limited wiring and all other Non-Power Limited wiring.

*Fig. 2 - VGSM-120 wiring diagram*
Auxiliary connections

The auxiliary connections are not necessary for the Communicator operation, but they maximize the versatility of this device. These connections are described in the following paragraph.

**Tamper** - The connection of the MAXIASNC tamper switch (optional) allows you to detect the Communicator cover opens. The tamper switch wires can be connected as follow.

- To the panel tamper line or a different 24h zone. Read the panel instructions for more information.
- To terminals [ T3 ] and of the VGSM-120, to send a SMS and/or Voice message, to one or more telephone numbers, when the Communicator cover is removed.
- Communicator cover is removed.

The second solution requires to program the Communicator by the **VGSM-120 Console**, as indicated in the Programming the device->Optional Tamper Programming section). After connecting the MAXIASNC tamper switch and programming the Communicator, close the cover and power up. After the initialization of the Communicator, open the cover and check that the SMS and/or Voice message has been sent to the programmed telephone numbers.
4. STATUS LEDS

There are 5 LEDs on the PCB (see Figure 3): three green LEDs (L1, L2 and L3), one yellow LED (L4) and one red LED (L5). These indicate the connection, transmission, malfunction conditions and the Communicator status (see table 2).

Note: During initialization and the programming phase, the LEDs flash.

- **RED** — This LED is normally OFF. It indicates malfunctioning by flashing in the event of trouble. On power-up, this Device will check for certain trouble conditions to be met shown in the opposite table. The most significant malfunctioning status will be indicated, with the corresponding number of flashes of the RED LED (L5), (see the opposite table for number of flashes and malfunctioning indication priority).

- **YELLOW** — This LED will switch ON when the interface switches to the GSM Network (due to land line trouble or the lack of this line). If it flashes slowly, it indicates that a call is taking place on the GSM network (both incoming and outgoing). If lit steadily along with the red LED, this indicates that the default manufacturer data is loading.

- **GREEN** — The three green LEDs (L1, L2 e L3) indicate the GSM signal strength and status (Table 2), as illustrated in Figure 3:
  - **The first LED (L1)** near the fixing hole. If this LED is OFF, the GSM Network service is unavailable (NO SERVICE). If only this LED is ON, the GSM Network reception is weak but sufficient to manage all telephone communications.
  - **The second LED (L2)**. When this LED is ON, the reception is good. This LED will switch ON only when the first GREEN LED is ON.
  - **The third LED (L3)**. When this LED is ON, indicates excellent GSM signal strength; it only illuminates when the first and second LEDs are already ON.

<table>
<thead>
<tr>
<th>Indication priority</th>
<th>Type of malfunction</th>
<th>Red LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (HIGH)</td>
<td>Firmware problem (incorrect firmware)</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>Power supply problem</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>GSM module problem</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>SIM problem during operation</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>SIM problem during initialization</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>GSM reception problem</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>GPRS problem</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>Receiver not available</td>
<td>7</td>
</tr>
<tr>
<td>8 (LOW)</td>
<td>Monitoring receiver not detected (receiver 1)</td>
<td>8</td>
</tr>
<tr>
<td>—</td>
<td>No Troubles</td>
<td>Off</td>
</tr>
</tbody>
</table>
### Fig. 3 - Operation indicator LEDs

LEDs Indicating GSM reception

GSM reception level symbol

Operation indicator LEDs

---

#### Table 2 - BGSM-120BA Communicator status indications provided by the flashing of the green LEDs (L1, L2, L3).

<table>
<thead>
<tr>
<th>Green LED flashes</th>
<th>Meaning of indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>Voice message transmission in progress.</td>
</tr>
<tr>
<td>L3</td>
<td>Remote Session; will flash until you exit the GPRS remote session.</td>
</tr>
<tr>
<td>L1+L2</td>
<td>Service mode; flashing continues until the device exits this mode.</td>
</tr>
<tr>
<td>L2+L3</td>
<td>Incoming SMS message; will flash for 5 seconds.</td>
</tr>
<tr>
<td>L1+L2+L3</td>
<td>The Communicator is initialising; flashing continues until a GSM signal is found.</td>
</tr>
</tbody>
</table>
5. OPERATING PRINCIPLES
This Communicator offers the option of selecting the “Primary Path” for communication purposes. Will provide the line ring voltage for incoming calls and will decode DTMF dialing. The Simulated land line provides the alarm control panel or an alternative communication terminal, with a backup line in the event of PSTN line trouble. Commutation between PSTN and GSM, does NOT occur during ongoing calls. The Operating priority (selected during programming) determines how this Communicator manages communication (SMS and voice), as well as calls from telephone devices connected to the LI terminals (such as a burglar alarm control panel).

Note: This Communicator is unable to decode Pulse dialing.
Note: To prevent any unwanted use of a simulated line via GSM, the equipment gives out a signal in the form of a double beep during vocal calls. The first double beep is produced after 5 minutes and the following ones at 30 second intervals each.

Restore default programming
To restore the default programming of the transmitter, proceed as follows:
1. Disconnect the transmitter from the power supply.
2. Keep terminals 1 and 4 on connector [9] (fig. 4, page 15) short-circuited, using clamps for example, and restore the power supply.
3. The 5 LEDs (L1, L2, L3, L4 and L5) will light up briefly (less than 1 second).
4. As soon as the short circuit is detected, the 3 green LEDs (L1, L2, L3) switch off, while the yellow and red LEDs (L4, L5) remain illuminated (for a few seconds) to indicate that default programming is being restored.
5. When the yellow and red LEDs (L4, L5) light up, remove the short circuit between terminals 1 and 4 on connector [9] (fig. 4, page 15).
6. Once this procedure is complete, the 3 green LEDs flash to indicate that the transmitter is initialising.

Note: Recorded voice messages are NOT deleted when the default settings are restored.

PSTN pre-set channel
If the voltage on the land line terminals (LE) drops below 3 Vdc for a period of between 10 to 3600 seconds (programmable value), this Device will switch the connected telephone device (connected to the LI terminals) to the GSM Network. When the PSTN telephone line is restored, it commutates once again, after a programmed period of time, to the PSTN telephone line.

Note: You can force the commutation on the GSM/GPRS channel, even when there is the land line by entering the prefix “9999” in front of the telephone number dialed by the Control Panel (for further details see the table on the right and the paragraph “GPRS->Telephone numbers to decode”).

Note: The telephone numbers for the PTM function (see “PTM->Telephone Numbers”) and those to be decoded (see “GPRS->Telephone numbers to decode”) must be entered WITHOUT the prefix “9999”.

Note: If, for any reason, the device is on the GSM simulated line, the prefix “9999”, if present, will be removed from the dialed number.

<table>
<thead>
<tr>
<th>Number dialed by the Panel</th>
<th>Telephone Line</th>
<th>Number in the &quot;Telephone numbers to decode&quot; list</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>0123456789</td>
<td>PSTN</td>
<td>None</td>
<td>Voice call on PSTN of the number 0123456789.</td>
</tr>
<tr>
<td>99990123456789</td>
<td>PSTN</td>
<td>0123456789</td>
<td>Contact ID communication on GPRS.</td>
</tr>
<tr>
<td>99990123456789</td>
<td>PSTN</td>
<td>None</td>
<td>Voice and/or Contact ID call on GSM of the number 0123456789.</td>
</tr>
<tr>
<td>99990123456789</td>
<td>Simulated on GSM</td>
<td>0123456789</td>
<td>Contact ID communication on GPRS.</td>
</tr>
<tr>
<td>99990123456789</td>
<td>Simulated on GSM</td>
<td>None</td>
<td>Voice and/or Contact ID call on GSM of the number 0123456789.</td>
</tr>
</tbody>
</table>
GSM pre-set channel
This provides the devices connected to the LI terminals with a simulated line if GSM reception is detected. If there is no GSM reception, it commutates to the PSTN telephone line.

Contact ID transmission sequence on GPRS
The Communicator, if telephone numbers have been entered on the page GPRS->Telephone numbers to decode for decoding using the VGSM-120 Console software, directs calls to these numbers over the GPRS line.

- When an event is triggered, the Alarm Panel goes off-hook.
- The dial tone is simulated.
- Control Panel dials the number of the central station. Ensure the alarm panel inserts a minimum 1-second pause, or has dial tone search enabled before dialing the number.
- The Communicator will send the required Contact ID dual tone handshake.
- After receiving the handshake, panel transmits alarm message in DTMF format.
- The Communicator decodes and transforms DTMF digits into the packet and sends it to the Central Station Receiver over the GPRS network.
- The receiver acknowledges the event and sends the command to this Communicator, which generates the corresponding kiss-off signal (at a frequency of 1400 Hz) and sends it to the control panel.
- After the Communicator generates kiss-off, the panel goes on-hook if no more alarms need to be sent, or it can send the next alarm.

SMS dialer
In SMS dialer operating mode, one or more telephone numbers (the first 8 entries in the phonebook) are sent SMS messages (as programmed previously) corresponding to the following events (see table below):

<table>
<thead>
<tr>
<th>No.</th>
<th>Event description</th>
<th>Programmed telephone numbers (first 8 entries in the phonebook)</th>
<th>SMS message</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Input 1 Event</td>
<td>[ ] [ ] [ ] [ ] [ ] [ ] [ ] [ ]</td>
<td>*SMS string</td>
</tr>
<tr>
<td>2</td>
<td>Input 1 Restore</td>
<td>[ ] [ ] [ ] [ ] [ ] [ ] [ ] [ ]</td>
<td>*SMS string</td>
</tr>
<tr>
<td>3</td>
<td>Input 2 Event</td>
<td>[ ] [ ] [ ] [ ] [ ] [ ] [ ] [ ]</td>
<td>*SMS string</td>
</tr>
<tr>
<td>4</td>
<td>Input 2 Restore</td>
<td>[ ] [ ] [ ] [ ] [ ] [ ] [ ] [ ]</td>
<td>*SMS string</td>
</tr>
<tr>
<td>5</td>
<td>Input 3 Event</td>
<td>[ ] [ ] [ ] [ ] [ ] [ ] [ ] [ ]</td>
<td>*SMS string</td>
</tr>
<tr>
<td>6</td>
<td>Input 3 Restore</td>
<td>[ ] [ ] [ ] [ ] [ ] [ ] [ ] [ ]</td>
<td>*SMS string</td>
</tr>
<tr>
<td>7</td>
<td>PSTN Fault Event</td>
<td>[ ] [ ] [ ] [ ] [ ] [ ] [ ] [ ]</td>
<td>*SMS string</td>
</tr>
<tr>
<td>8</td>
<td>PSTN Fault Restore</td>
<td>[ ] [ ] [ ] [ ] [ ] [ ] [ ] [ ]</td>
<td>*SMS string</td>
</tr>
<tr>
<td>9</td>
<td>Mains Fault Event</td>
<td>[ ] [ ] [ ] [ ] [ ] [ ] [ ] [ ]</td>
<td>*SMS string</td>
</tr>
<tr>
<td>10</td>
<td>Mains Fault Restore</td>
<td>[ ] [ ] [ ] [ ] [ ] [ ] [ ] [ ]</td>
<td>*SMS string</td>
</tr>
<tr>
<td>11</td>
<td>Periodic SMS</td>
<td>[ ] [ ] [ ] [ ] [ ] [ ] [ ] [ ]</td>
<td>*SMS string</td>
</tr>
</tbody>
</table>

- Event disabled on telephone number
- Event enabled on telephone number
- The SMS string may be up to 100 characters long

- Alarm indications which may occur on one or more of the 3 programmable input lines. Bear in mind that 2 SMS messages can be programmed for each of the 3 input lines on the device, one for Activation and one for Resetting.
- PSTN line test. 2 SMS messages may be programmed: one for PSTN line absence and one for Resetting.
- Power supply voltage test. 2 SMS messages may be programmed: one indicating Power supply voltage problems and one for Resetting.
- Periodic SMS message, with a programmable time period between 1 hour and 1 year.

Note: An SMS message is transmitted when one of the above events occurs, for which an SMS message and at least one telephone number has been programmed.
Voice dialer

During operation in Voice dialer mode, one or more telephone numbers (the first 8 entries in the phonebook) are sent a pre-recorded voice message. Up to 8 messages may be recorded, each with a maximum duration of 16 seconds. Each message is recorded onto a solid state memory, thereby eliminating all problems linked to the use of magnetic tape, such as the deterioration of message quality over time; the jamming of mechanical systems after extended periods of inactivity, etc… The messages are linked to the following events (see table below):

<table>
<thead>
<tr>
<th>No.</th>
<th>Event description</th>
<th>Programmed telephone numbers (first 8 entries in the phonebook)</th>
<th>Mess. #1</th>
<th>Mess. #2</th>
<th>Mess. #3</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Input 1 Event</td>
<td>□ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Input 1 Restore</td>
<td>□ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Input 2 Event</td>
<td>□ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Input 2 Restore</td>
<td>□ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Input 3 Event</td>
<td>□ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Input 3 Restore</td>
<td>□ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>PSTN Fault Event</td>
<td>□ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>PSTN Fault Restore</td>
<td>□ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Mains Fault Event</td>
<td>□ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Mains Fault Restore</td>
<td>□ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Periodic Call</td>
<td>□ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □ □</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Event disabled on telephone number
- Event enabled on telephone number

- Alarm indications which may occur on one or more of the 3 programmable input lines. Bear in mind that 2 voice messages can be recorded for each of the 3 input lines on the device, one for Activation and one for Resetting.
- PSTN line test. 2 voice messages may be recorded: one for PSTN line absence and one for Resetting.
- Power supply voltage test. 2 voice messages may be programmed: one indicating Power supply voltage problems and one for Resetting.
- Periodic voice message, with a programmable time period between 1 hour and 1 year.

A voice call takes place when an event occurs on a channel for which a voice message and at least one telephone number has been programmed.

In this case, the Communicator performs the following steps:

1. The Communicator selects a telephone number and forwards the call over the GSM telephone line.
2. The Communicator makes sure that the number is not busy and that there are no problems on the GSM network, so that it can proceed with the next step, otherwise the call will end and step 1 will be attempted again, up to a maximum of 8 times (depending on the programmed value). After 8 attempts the call cycle will be considered complete. If the alarm channel has been programmed to call several telephone numbers, they will be called in a set sequence. By doing this, for example, the possibility of calling a busy number several times in the space of a few seconds can be avoided.
3. The Communicator waits for a response from the number called for a period of up to 60 seconds. If the outcome is positive, the Communicator moves on to step 4; otherwise the call will end and step 1 will be attempted again, up to a maximum of 8 times (depending on the programmed value). After 8 attempts the call cycle will be considered complete.
4. The Communicator plays the message corresponding to the channel where the alarm is taking place, the call is considered completed only once the message has been received, or when the key is pressed (if "Call Confirmation" has been selected, see the Voice dialer->Call Confirmation section) on the phone receiving the message. If, at the selection stage, several events occurred causing several different messages to be sent to the same telephone number, these messages are reproduced (each for a maximum of 8 times, depending on the programmed value) in sequence during the same telephone communication, thus avoiding calls being made to the same number several times. If at the end of the call cycle, the line which caused the Communicator to be activated is still in alarm mode, the procedure described above will not be repeated again. In fact, the line that caused a call cycle must return to standby mode before a new cycle is activated.
Priority management

The Communicator can be used to transmit alarm events and SMS or voice messages; several priorities may be programmed using the VGSM-120 Console software (please refer to the section corresponding to programming procedures using the VGSM-120 Console software). The table below lists the default priority management settings.

<table>
<thead>
<tr>
<th>Event priority</th>
<th>Event description</th>
<th>Default settings</th>
<th>Can be programmed using software</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (HIGH)</td>
<td>Request LI line (release)</td>
<td>☑</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Voice dialer (voice messages)</td>
<td>☐</td>
<td>Yes</td>
</tr>
<tr>
<td>*3 (LOW)</td>
<td>GPRS supervision</td>
<td>☐</td>
<td>No</td>
</tr>
</tbody>
</table>

* The GPRS supervision event has the lowest priority and cannot be programmed using software

Simulated telephone line priority

When the device connected to the LI terminals requests the line, any other call made at that moment in Voice dialer mode will be terminated. The calls requested by the device connected to the LI terminals (a burglar alarm control unit, for example) take place in this manner. When the device connected to the LI terminals frees the line, the voice dialer will resume the suspended calls and begin sending voice messages again.

SMS dialer priority

If a piece of equipment connected to the LI terminals is making a call over the GSM network through this dialer and an SMS dialer action needs to be performed, the call from the interface will not be terminated and the SMS message will still be sent.

Dialer event priority

The SMS messages have a lower priority than Voice messages but they cannot be interrupted while they are transmitted: in this case, the queued Voice message will be sent at the end of the SMS message sending.

Pay As You Go Balance

If the VGSM-120 Console software has been used to program the device (see Options->Pay As You Go), it will be possible to check how much credit is left on the pre-paid SIM CARD. If the credit balance check feature is enabled, an SMS providing credit balance information (supplied by the operator) is sent to the first number in the phonebook at regular intervals. For all operators which support credit balance requests via a network command, it will be possible to enter a request for information using the VGSM-120 Console software.

**Note:** The pre-paid SIM CARD credit management service may be suspended at any time, at the discretion of each individual GSM network operator.

(PTM) monitoring of communication with the control unit

The constant monitoring of communication with the control unit (PTM function) allows the Communicator to transmit calls via the GSM network if communication between the alarm control unit and the surveillance control unit does not take place successfully over the PSTN telephone line. If programmed (using the VGSM-120 Console software PTM page), this feature only works when the PSTN line is connected to the LE terminals. The PTM function correlates to the following Communicator alarm transmission modes:
1. Alarm on GPRS (IP communication - receiver).
2. Alarm on GSM (voice mode).

**Note:** The PSTN Fault event occurs when the PTM function activates.
6. ACTIVATING THE OUTPUTS

The VGSM-120 has 3 terminals (the T1, T2 and T3 terminals) that can be programmable as Inputs or/and Output: this terminals are programmed as Outputs by default. The Open-Collector Outputs can be activated automatically (when certain pre-programmed events occur) or remotely, through SMS trasmission or caller identification from a number programmed previously.

Activating/Deactivating Automatic Outputs

The T1,T2 and T3 Open Collector outputs can be activated automatically by the following events:

- Land line trouble (line down);
- GSM Network trouble (Limited/No Service);
- Supervision message missing;
- Internal event communication failed (FTC).

Note: Once an OC output has been automatically activated, it will only return to standby mode when all the causes of activation have been cleared, except if there is a Failure To Communicate an internal event (FTC), in which case it returns to standby mode after the ON Time has expired.

Remote Activation and Deactivation of the Outputs

CAUTION! The GSM connection must be established before the outputs can be activated/deactivated remotely.

We recommend the device is programmed with the Black list enabled (Options->Dial Options) and White list disabled (Phonebook->White list) for the numbers you wish to use for this function. The number used to activate the outputs via Caller Identification must be visible.

The Open Collector outputs can be set as Bistable (activation and deactivation takes place by means of 2 separate commands) or Monostable (the output remains active for the ON time and returns to standby mode when this period has elapsed or when it is deactivated by means the specific SMS). Moreover, every output can be programmed to provide a confirmation signal (an SMS programmed previously if output activation/deactivation is performed via SMS, or a confirmation ring if output activation/deactivation is performed via caller identification).

Note: For further information on the terms “Control string” and “User code” used in the following sections, please refer to the “I/O” and “Options->Codes” sections of the “PROGRAMMING VIA PC” chapter.

Bistable outputs

Open collector outputs set as bistable can be activated in 2 ways:

1. By sending an SMS consisting of the User code between two # characters, the Control string (Control String can not have initial blank spaces) and the characters “=ON#”, as follows:
   
   #User code#String=ON#  
   
   (example: #9876#HOUSELIGHT=ON#)

2. Through caller identification: in this case the output is activated at “cost-free” as the Communicator, after identifying the caller, rejects the call and activates the output.

   Note: A bistable OC output can ONLY be deactivated by sending an SMS message consisting of the User code between two # characters, the Control string and the characters “=OFF#”, as follows:
   
   #User code#String=OFF#  
   
   (example: #9876#HOUSELIGHT=OFF#)

   Note: The default User code is ‘0001’; if you wish to change it, please refer to the section “Remote programming by SMS message->Changing the User code”.

Monostable Outputs

OC outputs set as Monostable may be activated in 2 ways, through Caller Identification and via SMS.
SMS

Send an SMS consisting of the User code between the # characters, the Control string (Control String can not have initial blank spaces) and the characters “=ON#”, “=ON#TonU#” or “=OFF#”, as follows:

- #User code#String=ON#
- #User code#String=ON#TonU#
- #User code#String=OFF#

The “=ON#TonU#” option is parameter allows to set the ON Time from 1 to 86400 seconds, with 1 second steps. The ON Time can be set by means of the Communicator’s Console software. “Ton” is the required value and “U” is the unit in hours (H), minutes (M) and seconds (S), as shown in the following example:

<table>
<thead>
<tr>
<th>SMS</th>
<th>Output operating mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>#9876#HOUSELIGHT=ON#</td>
<td>Bistable Activation</td>
</tr>
<tr>
<td>#9876#HOUSELIGHT=ON#3600#</td>
<td>Active for 3600 seconds</td>
</tr>
<tr>
<td>#9876#HOUSELIGHT=ON#50M#</td>
<td>Active for 50 minutes</td>
</tr>
<tr>
<td>#9876#HOUSELIGHT=ON#3600M#</td>
<td>Active as per software programming, the set ON time does not apply</td>
</tr>
</tbody>
</table>

Note: Remove the “TonU” parameter, leaving the “##” characters, to activate the output by SMS as programmed.

(example: #9876#HOUSELIGHT=ON##)

Caller Identification

Through caller identification: in this case the output is activated at “cost-free” as the Communicator, after identifying the caller, rejects the call and activates the output.

Note: Monostable OC outputs deactivate (switch OFF) automatically when the programmed ON Time expires.

The ON time may be set to a period of time between 1 and 86400 seconds, in steps of 1 second.

Note: The default User code is ‘0001’; if you wish to change it, please refer to the section “Remote programming by SMS message->Changing the User code”.
7. REMOTE PROGRAMMING BY SMS MESSAGE

In addition to the processes described in the section *Remote activation and deactivation of the outputs*, it is also possible to carry out other remote procedures through the transmission of various SMS messages.

**Changing the user code**
The default user code is ‘0001’; to change it, send an SMS message consisting of the characters “#CUC” followed by the old **User code** and the new **User code** between * characters, in accordance with the following formula:

#CUC*User code*New User code*

You will receive an SMS confirmation if the User Code has been changed.

*Note:* The User code may only consist of numbers from 0 to 9 (maximum 4 digits).

**Enabling or disabling remote programming**
Remote programming makes it possible to use the functionalities of the **VGSM-120 Console** software via a network. In order to remotely manage the parameters of the Alarm Communicator, remote programming must be enabled. This can be done using the **VGSM-120 Console** software (see the *Programming via PC->GPRS->Remote Programming* section), or by sending an SMS message consisting of the characters “#UWS” followed by the **User code** and “ON” between * characters, in accordance with the following formula:

#UWS*User code*ON*

To disable the Remote Programming, send the following SMS message:

#UWS*User code*OFF*

A text message will confirm whether the command was successful.

**Changing the Installer code**
The Installer Code (maximum 4 digits) is used for accessing the remote programming interface (see the *Programming via PC->Codes->Installer Code* section). The default installer code is ‘0002’; to change it, send an SMS message consisting of the characters “#CIC” followed by the old **Installer code** and the new **Installer code** between * characters, in accordance with the following formula:

#CIC*Installer code*New installer code*

You will receive an SMS confirmation if the Installer Code has been changed.

*Note:* The Installer code may only consist of numbers from 0 to 9 (maximum 4 digits).

**Credit balance check**
To find out the credit balance via SMS, you can either use the **VGSM-120 Console** software (see section *Programming via PC->Options->Pay As You Go*), or you can find out remotely by sending an SMS message consisting of the characters “#CCC” followed by the * character, in accordance with the following formula:

#CCC*

*Note:* The balance SMS will be sent to the Telephone Number #1 of the Phonebook. The pre-paid SIM CARD credit management service may be suspended at any time, at the discretion of each individual GSM network operator.
8. PROGRAMMING VIA PC

Note: For proper function of this Communicator, use a 32 K SIM CARD (or higher).

For programming, the PC-Link cable (not supplied) must be connected to the Connector [9] of the Communicator and a COM port on the PC (see Fig. 4); the VGSM-120 Console application is also required. The PC-Link cable shown in Figure 4a, or the PC-Link cable shown in Figure 4b, can be used for the connection. Make sure you insert the PC-Link cable connector in the right way. Once the PC-Link cable has been connected, set the computer COM port through the the Options->Serial ports. Check the serial link and the serial port settings in case of communication problem, or use a different USB-RS232 adapter.

Note: To install and run the VGSM-120 Console application, you will need to log on to the PC as the Administrator; we also recommend to verify the firewall’s options if problems arise while the application is being installed.

Viewing the Device Settings

To view the Communicator settings on the screen, use the Upload from board icon.

Downloading the Device Settings

Once programming has been completed (or an uploaded file containing existing data has been modified), download the data into the Device, using the Download to board icon.

Preliminary operations

When the application starts, you will be presented with the Main window: if you use the mouse to click the menu option Untitled #1 in the top left-hand part, two sections appear.

- The following sections may be found within the general parameters section:

  Customer information: this section can be used to recall and update the configuration corresponding to a particular client as follows:
  1. Left-click on the application.
  2. Enter or update the information relating to the customer and the system. Click to confirm.

Upload from board: If this icon is selected, the data programmed on the board is loaded onto the PC.

Download to board: If this icon is selected, the programmed data is sent to the board. Sending all of the device settings or some "GPRS", "I/O" and “Options” pages to the device will reset the Alarm Communicator.

Factory defaults: Select this icon to restore the default settings. It should be noted that restoring the default settings does not delete any voice messages recorded.

Board reset: If this icon is selected, the Communicator is reset.
**Phonebook**: Telephone contact list page.

**Options**: Options page.

**GPRS**: GPRS parameters page.

**Status**: Page used to check the status of the Communicator.

**PTM**: PTM function setup page.

**I/O**: Communicator output/input parameter programming page.

**Voice Dialer**: Page used to set all parameters relating to the voice dialer.

**SMS Dialer**: Page is used to program all SMS dialer options.

**Voice Message**: Page used to manage voice messages.

To start the configuration of a new Customer, click on **File->New**.

To display the list of customers stored in the archive, select the menu command **File->Open**. This section will allow you to delete or retrieve configuration data, as follows:

1. Using the right button on the mouse, click on the Customer’s name.

2. Click **Load** to upload the respective data from the Hard-Disk, or **Delete selected customer** to delete the data configuration.

   You can load the configuration data by double clicking the respective name field.

   You can list Customers in alphabetical or code order by clicking the heading of the column concerned.

The configuration data are grouped in the following pages. The **(Status)** page is for "Supervisory and Control" purposes. All the pages are described in detail in this section.
Phonebook
The Telephone Page phonebook holds 100 telephone numbers.

**Note:** The remaining balance on the pre-paid SIM card is sent via SMS to phone number #1.

- **Description**: Enter an alphanumeric string of up to 16 characters.
- **Telephone number**: Enter a phone number including the country code in the format "+xxx" (e.g.: +39 for Italy). A maximum of 16 digits is allowed (the plus sign "+") counts as a digit).
- **Activates Output**: Select the telephone numbers which can activate the outputs T1 (OC1), T2 (OC2) and T3 (OC3) when the Communicator receives a call from them. This function does not depend on the **White List** or **Black List** options (Options page->Dial options). The Calling Line Identifier service must be enabled before the output can be activated.

**Note:** To activate the output program the T1 (OC1), T2 (OC2) and T3 (OC3) terminals as "Output" and enable "Reserved Output" (see pages referring to I/O->Type and I/O->Reserved Output).

- **Output Activation Confirmation**: Tick this box to receive a confirmation ring once the output has been activated.

**CAUTION!**
- The ring will be received 1 minute after the output has been activated;
- If the transmitter is already in operation (for example: the GSM channel is busy with a voice communication), the confirmation ring will not take place;
- The option "Output Activation Confirmation" cancels the incoming call after approximately 5 s, even if the "Black list" option is not enabled.

- **White List**: Enable ☑ or disable ☐ the **White List** area would allow the Communicator to accept or refuse incoming calls. The Communicator **accepts incoming calls**, forwarding them to the telephone devices connected to LI terminals (such as a burglar alarm control panel); this is possible only if LI is active as a simulated line via GSM. The functioning mode of the **White List** option is linked to the ☑ selection or non-selection ☐ of the **Black List**, area which is present on the inside of the Options page->Dial options, as seen in the following table:

<table>
<thead>
<tr>
<th>White List</th>
<th>Black List</th>
<th>Functioning mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐</td>
<td>☐</td>
<td>Accept incoming calls from any number</td>
</tr>
<tr>
<td>☐</td>
<td>☑</td>
<td>Refuse any incoming call</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
<td>Accept incoming calls only from numbers having an enabled White List option, refuse call coming from all other numbers</td>
</tr>
</tbody>
</table>

Options
This page is used to set the options relating to the Communicator board.

Dial options
This part is used to enter some of the characteristics relating to the telephone numbers used.

- **Prefix**: This Device will prefix the digits entered in this field to all the telephone numbers dialled through the **GSM Interface function**. If necessary enter a Prefix (maximum 8 digits) in this field. If no Prefix is required, leave this field empty.

- **Digits to Remove**: If this Communicator is connected downstream to a switchboard, the telephone numbers (programmed on the Control panel) must be preceded by the switchboard number (normally one digit). As the switchboard number is not required when calls are sent over the GSM Network, it must be removed from the digits which form the telephone number. Enter the number of digits that form the switchboard number (e.g. if switchboard number is 01, enter 2 in the "Digits to remove" field, as 2 numbers form the switchboard number).

**Note:** The telephone number should at least have two digits more that the number in the “Digits to remove” area, otherwise the engaged tone will be come through, e.g.:

- the dialled telephone number is 0123, with 2 digits to be removed = correct, the remaining number to be inserted is 23.
- the dialled telephone number is 123, with 2 digits to be removed = engaged tone, the remaining number to be inserted is 3.
• **Enable Black List**: Check this box if you do not wish to receive calls from telephone numbers, authorising only the numbers selected previously using the **White List** function (Phonebook page->White List).

**Note:** Only the “Black List” option cancels the call immediately.

**Note:** When the “Black List” and “Activates Output” options are enabled, there is a delay (some seconds) before the call is cancelled;
When the Ring is selected for the “Activates Output” option, there is a delay (some seconds) before the call is cancelled; If the output cannot be activated, VGSM-120 cancels the call immediately.

**Event priority**

This page may be used to program several Communicator priorities, for the transmission of alarm events (see **Priority management** section).

**Note:** **Off-Hook**: This box can be used to establish the priority of telephone devices connected to the LI terminals (such as a burglar alarm control panel). It is enabled ☑ by default; to disable it remove the tick ☐.

**Note:** **Voice Dialer**: This box can be used to establish Voice dialer (voice message) priority. It is disabled ☐ by default; to enable it, mark it with a tick ☑.

**Codes**

- **UserCode**: Enter the account code in this box (maximum 4 numeric characters) to activate outputs remotely. For further information, please refer to the section “Activating the Outputs->Remote Activation and Deactivation of the Outputs”. The default code is set to ‘0001’.

- **Installer Code**: The Installer code can be entered in this field (maximum 4 numerical characters). This code allows access to the “Remote Programming” interface when required. The default code is set to ‘0002’.

**Generic**

This section may be used to set the audio levels of the loudspeaker and microphone fitted to the GSM Communicator.

- **Speaker volume**: The volume of the loudspeaker may be adjusted by shifting the cursor.

- **Microphone volume**: The volume of the microphone may be adjusted by shifting the cursor.

**CAUTION!** If the volume on the microphone is too high, it may corrupt the DTMF tones from devices connected to the LI terminals, making them unrecognizable.

- **Tones...**: Select the name of Communicator’s country of installation; the selected country will establish a series of parameters for the proper working of the simulated telephone call.

- **LE failure timeout**: Enter the time in seconds (between 10 and 3600 seconds) for the Line down on the LE terminals, before the PSTN Fault event occurs.

  **Note:** The time may increase up to 60 seconds if some telephone devices are connected to the terminals LI.

- **LE restore timeout**: Enter the time in seconds (from 30 to 3600) that the telephone line must be connected to the LE terminals before the PSTN Fault event is reset.

**System**

This section refers to the System.

- **SIM Phone Number**: Enter the telephone number of the Communicator’s SIM CARD (maximum 16 digits).

- **Auto Clock Adjusting**: Checking this option the device will update the system date and time by sending an SMS itself.

- **SMS Service Center Address**: This is a read-only option. It shows the number of the SMS services centre on the SIM CARD.
Pay As You Go

Note: The pre-paid SIM CARD credit management service may be suspended at any time, at the discretion of each individual GSM network operator.

This section can be used to send an SMS providing credit balance information (supplied by the operator) to the first number in the phonebook at regular intervals. Program the following options for a correct credit balance check request, in accordance with the type of operator used:

- **Enquiry Type**: selection of enquiry type (SMS, Call, Service Command).
- **Enquiry Number**: telephone number to call or to which an SMS message should be sent in order to request credit balance information.
- **Balance Message**: string used to send SMS messages and to make requests via service commands.

<table>
<thead>
<tr>
<th>Options</th>
<th>Vodafone</th>
<th>Wind</th>
<th>TIM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enquiry Type</td>
<td>Call</td>
<td>Service Command</td>
<td>SMS</td>
</tr>
<tr>
<td>Enquiry Number</td>
<td>404</td>
<td>40916</td>
<td></td>
</tr>
<tr>
<td>Balance Message</td>
<td>*123#</td>
<td>PRE CRE SIN</td>
<td></td>
</tr>
</tbody>
</table>

- **Interval**: Enter the interval (HH-DD) at which you wish to send a periodic SMS containing credit balance information (if supported by your telephone operator). The interval consists of the following values:
  - **(HH)** next message time - Select the time at which you wish to send the next periodic SMS. The interval for these values may be set between 0 and 23.
  - **(DD)** next message day - Select the day on which you wish to send the next periodic SMS. The interval for these values may be set between 0 and 365.

Primary Path

The user can program the primary communication line.

- **Primary Path**: Select the primary GSM or PSTN line using this field.

GPRS

This page outlines the GPRS configuration options.

Note: Bearing in mind the delays which may occur in transmission via GPRS, which are caused by the activities of the network manager, we recommend you program as many call attempts to the burglar alarm control panel as possible, and that you also provide a backup telephone number which transmits alarms via GSM as well as via GPRS.

Access Point Name 1 and Access Point Name 2

Enter the **Access Point Name** of the GPRS service provider being used. Enter the name of the IP address service provider in this box. **Access Point Name 2** is considered a backup parameter.

**WARNING**: Make sure to enter the correct APN for WAP/GPRS access - otherwise some functions may be limited (for more information, please contact your customer support).

Main Receiver, Local Port 1 and Alarm Port 1 IP address

Enter the primary receiver IP addresses and port numbers. For **Sur-Gard System III** and **System II** enter the IP address and the port listed in the **Alarm Port** section.

Backup Receiver, Local Port 2 and Alarm Port 2 IP address

This check box is used to enter the second IP address for the receiver and the port number, with the difference that these parameters are considered as a backup receiver. The Communicator only recognises this box if the parameters corresponding to the **Main Receiver, Local Port 1** and **Alarm Port 1** address have been entered. Furthermore, the **Enable supervision** and **Supervision time** boxes refer only to the main receiver.
APN1 Username and Password, APN2 Username and Password

Some providers may require a user name and password to validate communication. If needed, enter this information here. APN2 Username and Password are considered to be backup data.

Telephone numbers to decode

This communicator permits communicating the events in the Contact ID format, via the GPRS network, also to the control panels that do not support this communication method.

To do this, you must setup a telephone number (the phone numbers can be "virtual" or "real") on the control panel for event communication in Contact ID format (e.g. you can setup 0123), then you must enter the same telephone number in one of this fields (you can program up to four telephone numbers for this function). When the Communicator recognizes a call from one of these numbers, automatically transcodes the event in digital format and forwards it on the GPRS network to the set receiver (refer to the "Main Receiver" and "Backup Receiver” options).

**Note:** The telephone number must be of at least 2 digits.
The options “Prefix” and “Digits to remove” have no effect on the “Telephone numbers to decode”.
The “Telephone numbers to decode” must exactly match with the telephone numbers set for the control panel. Leave these fields empty if you don’t use this function. For this feature to work correctly, the "Main Receiver" (and, where necessary the "Backup Receiver") option must be selected.

DNIS

If required, enter the Dialed Number Identification Service number.

Account code

The account code for communication with Sur-Gard System III or System II receivers must be entered in this box.

**Note:** Ensure a different Customer Code is assigned to each communicator that transmits events to the same receiver.

Enable Supervision

To enable supervision, select this option. The supervision option is ONLY available to the main receiver. The supervision messages are not sent when the device is performing a voice call (on GSM).

Supervision time (sec)

Set the Supervision time for the monitored receivers. It is possible to set a Supervision time between a minimum of 5 second and a maximum of 65535 seconds, with steps of 1 second.

Status

This page will allow you to monitor and control in real-time all the Communicator functions.

**ATTENTION:** This page is updated every 5 seconds.

Status section

This section lists the most important data relating to the GSM module. The virtual display shows, in addition to the name of the GSM network manager, the GSM signal strength (this is displayed through a special indicator). The Device status indicator may be ON or OFF. The Device status indicator light when it is GREEN; proper function. When it is RED, this indicates that there is no communication between the software and the device; if it is ORANGE it means that there is a communication in course. For GPRS Main Receiver and GPRS Backup Receiver this indicator is ORANGE when the Receiver is initialized but NOT currently connected OR connected but NOT yet initialized.
PTM

This page refers to the “PTM (Panel Transmission Monitoring) function”, which allows the device to transmit calls over the GSM network in the event of failed communication between the control unit and the receiver on the PSTN telephone line.

*Note:* The Communicator restores to normal mode after 5 minutes on the GSM channel.

The PTM function considers communication to have failed when:

- It does not detect number dialing, if the “Check Dialing” option has been enabled (this option checks that telephone numbers have been dialed correctly).
- It does not detect a kiss-off (the signal transmitted by the receiver when successful event communication has ended).

*Note:* The kiss-off signal frequency is 1400 Hz.

All numbers are checked if the “Telephone Numbers” list is empty; otherwise only the numbers on the list will be checked.

Calls are transmitted over the GSM network when the programmed “Maximum Failure Number” has been reached.

- **Telephone Number:** Enter the telephone numbers (up to a maximum of 4) to be called using the PTM function. These fields are empty by default. If these fields are blank, the “PTM function” will check all the telephone numbers dialed by the control panel.

- **Check Dialing:** Disabled at factory default, if enabled, the missed dialing (i.e. when the PTM does not detect the number dialed by the control panel on the PSTN line) will be count as failure by the “PTM function”.

- **Max Failures:** In this box, enter the total number of errors detected by the Communicator above which the PTM function is activated. The PTM function is disabled by default (the default setting is 0); set a value from 1 to 4 to enable the PTM function.

I/O

This page is used to program input or output modes, output activation events, polarity (N.C. or N.O.), reserved outputs and remote activation SMS strings for reserved outputs.

- **Type:** This column can be used to program terminals T1, T2 and T3 for the following modes:
  - Input: Select this mode to enable the corresponding terminal as the input line. If this mode is selected, the Service column is activated (see below).
  - Output: Select this mode to enable the corresponding terminal as an open collector output.

  **CAUTION!** These settings also automatically update the parameters on the “SMS dialer”, “Voice dialer” and “Phonebook” pages.

- **Polarity:** This box is used to program the output/input standby status:
  - Normally Closed with the output/input in standby, the corresponding terminal is negative.
  - Normally Open with the output/input in standby, the corresponding terminal is floating.

  Click the box corresponding to the ‘Polarity’ column to invert the parameter currently displayed.

- **Activation events:** Click the column corresponding to the event to be programmed, in line with the relevant output. The tick indicates that when this event occurs, the relevant output will be activated. Click the boxes to enter/remove the tick.

  **CAUTION!** Programming the events linked to an output causes some of the boxes corresponding to that output to be disabled. Before you can begin programming, you will need to remove the ticks from various boxes.

  - **PSTN Fault:** If selected, the output will be activated in the event that the telephone line is not detected.
  - **GSM Fault:** If selected, the output will be activated if the GSM network is not detected.
  - **HB Fail:** If selected, the output will be activated in the event that the supervision message is not detected.
  - **FTC Signal:** if selected, the output will be activated if communication is not successful.
**Note:** The selection of the FTC Signal event enables the Monostable option and allows you to set the Monostable Time (ON Time).

- **Reserved Output:** When this option is selected, all other events selected to activate the corresponding output are ignored. Click the box corresponding to the output to be activated through caller recognition or via an SMS command. To activate the output using caller identification, program the telephone number on the “Phonebook” screen and enable the option “Activates output” (see page Phonebook->Activates output).

- **Service:** A tick ✓ in this column indicates that the Communicator is in its SERVICE status, i.e. when lines 1 and 2 become unbalanced, instead of making a call, the Communicator will take a specific action independently. An action may be specified for each line, in accordance with the table below. In any case, if these actions are selected, SMS messages are never sent in reference to inputs 1 and 2.

<table>
<thead>
<tr>
<th>Input line no.</th>
<th>Selection</th>
<th>Associated Service function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td>Forced switching on GSM network</td>
</tr>
<tr>
<td>2</td>
<td>B</td>
<td>Delete telephone queue</td>
</tr>
</tbody>
</table>

CAUTION! These settings also automatically update the parameters on the “SMS dialer”, “Voice dialer” and “Phonebook” pages.

- **Control String:** In this column, enter the string (maximum 16 alphanumeric characters) to be sent by SMS when you wish to activate/deactivate the corresponding remote output. This feature will operate even if caller identification is not enabled.

- **Activation Confirmation:** Use this column to select the type of confirmation you want when the output is activated. There are 3 different options to choose from: None, Ring or SMS (the latter option is not available if the Control string box has been left empty). The output activation confirmation is forwarded by means of a SMS when the output is activated by SMS.

### Table: Programming Effects on Activation Output

<table>
<thead>
<tr>
<th>Black List</th>
<th>White List</th>
<th>Activation Confirmation</th>
<th>Call Forwarded (only if the Communicator is switched to the GSM network)</th>
<th>Confirmation Ring</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐</td>
<td>☐</td>
<td>None</td>
<td>YES</td>
<td>NO</td>
</tr>
<tr>
<td>☐</td>
<td>☐</td>
<td>Ring</td>
<td>NO</td>
<td>YES</td>
</tr>
<tr>
<td>☐</td>
<td>☑</td>
<td>None</td>
<td>YES</td>
<td>NO</td>
</tr>
<tr>
<td>☐</td>
<td>☐</td>
<td>Ring</td>
<td>NO</td>
<td>YES</td>
</tr>
<tr>
<td>☑</td>
<td>☐</td>
<td>None</td>
<td>NO</td>
<td>NO</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
<td>None</td>
<td>YES</td>
<td>NO</td>
</tr>
<tr>
<td>☑</td>
<td>☐</td>
<td>Ring</td>
<td>NO</td>
<td>YES</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
<td>Ring</td>
<td>YES</td>
<td>YES</td>
</tr>
</tbody>
</table>

- **Monostable:** Normally the outputs, when activated, remain so until a deactivation command is received, at which point the output will revert to its standby status. If you want the output to revert to its standby status automatically after a set amount of time, select this option and set the activation time using the adjacent Monostable Time (sec) box.

- **Monostable Time (sec):** In this box, enter the value in seconds (from 1 to 86400 in steps of 1 second) indicating the time period for which the output, if set as Monostable, will remain active before reverting to its standby status (ON Time).
Voice Dialer

This section is used to program all parameters relating to the voice dialer, namely: the telephone numbers to call (the first 8 numbers in the phonebook), the number of repetitions for each message (minimum 1, maximum 8), the duration and number of the messages in accordance with the following specifications:

- **Description**: This column lists the events for which a voice message may be programmed.

  **Note:** To select voice messages for the 3 programmable input lines, set the corresponding terminal as an input (see I/O->Type).

- **Telephone numbers**: Click the ‘12345678’ columns in accordance with the desired event. The tick ✓ indicates that a particular telephone number will be called when an event occurs. Click the boxes to enter/remove the tick ☑.

  **Note:** The telephone numbers are the first 8 entries on the “Phonebook” page.

- **Voice Message**: Triple-click the ‘Message’ column corresponding to the desired event, then click the button to scroll through the list of messages (up to 8 messages can be selected, each with a maximum duration of 16 seconds) and select one. Up to 3 voice messages can be selected for each event (Message#1, Message#2, Message#3).

- **Repeat Call**: This field is used to enter the number of attempts to be performed (up to a maximum of 8) if the call is not successful.

- **Repeat Message**: This field is used to enter the number of times a message is repeated (up to a maximum of 8) when the call is answered.

- **Call All Numbers**: Select this option ☑ to call all telephone numbers programmed for an individual event and play the voice message assigned to it. If this option is not selected ☐, the dialer will end the voice calls as soon as one of them has been completed successfully.

- **Call Confirmation**: Select this option if you want the dialer to wait for confirmation from the remote user that the voice message has been received, otherwise the dialer will attempt to deliver the voice message again: the remote user can send confirmation by pressing the button on his/her telephone (only applies to touch-tone keypads).

  **CAUTION!** By pressing the button on your own telephone when listening to a voice message, both the current telephone call and any others in progress may be blocked.

  **CAUTION!** In some cases the dialer may misinterpret the answer from answering machines, ringback tones, GSM operator courtesy messages, etc. Users are advised to enable the “Call Confirmation” function.

Periodic voice

This section is used to program periodic voice message options.

**Note:** You MUST enter the “SIM Phone Number” and enable the “Auto Clock Adjusting” in the “Options” page to setup the Periodic Voice’s options.

- **Date of first send**: Select the date on which the first periodic voice message is to be sent.

- **Time of first send**: Select the time at which the first periodic voice message is to be sent.

- **Interval**: Enter the interval (HH-DD) at which subsequent periodic voice messages are to be sent. The interval consists of the following values:
  
  o (HH) next message time - Select the hour value for the next periodic voice message. The interval for these values may be set between 0 and 23.
  
  o (DD) next message day - Select the day value for the next periodic voice message. The interval for these values may be set between 0 and 365.

- **Update time**: Select this icon to get local date and time from the PC.
Local Service Mode

By selecting the **Local service mode** button, you can enable the voice messages playing/recording by a touchtone telephone connected to the [LI] terminals of the device (refer to “Local Voice Message Recording” and “Local Voice Message Replaying”). When this mode is enabled, the green LEDs L1 and L2 flash (see **Status Leds** - >table 2). The LEDs only stop flashing when the recording or replaying procedure is complete, or after 60 seconds have elapsed without any of the buttons being pressed.

**Note:** You can connect ONLY ONE telephone to the [LI] terminals for proper working of the Local Service Mode.

SMS dialer

This page is to setup the SMS dialer options, as indicated following.

- **Event type**: The ‘Event type’ column has 11 separate lines listing the events for which two SMS messages are sent, if programmed: one for activation and one for resetting (the "Periodic SMS" event only sends an activation SMS).

  **Note:** To select SMS messages for the 3 programmable input lines, set the corresponding terminal as an input (see I/O->Type).

- **Telephone numbers**: Click the ‘12345678’ columns in accordance with the desired input. A tick ✔ indicates that the SMS message will be sent to a particular telephone number when the corresponding event occurs.

  **Note:** The telephone numbers are the first 8 entries on the “Phonebook” page.

- **SMS String**: In the ‘SMS String’ column, click the box corresponding to the message to be programmed and enter the message you wish to send when the relevant event occurs (maximum 100 characters).

Periodic SMS

This section is used to program periodic SMS message options.

**Note:** You MUST enter the “SIM Phone Number” and enable the “Auto Clock Adjusting” in the “Options” page to setup the Periodic SMS’s options.

- **Date of First Send**: Select the date on which the first periodic SMS message is to be sent.

- **Time of First Send**: Select the time at which the first periodic SMS message is to be sent.

- **Interval**: Enter the interval (HH-DD) at which subsequent periodic SMS messages are to be sent. The interval consists of the following values:
  
  - (HH) next message time - Select the time at which you wish to send the next periodic SMS. The interval for these values may be set between 0 and 23.
  
  - (DD) next message day - Select the day on which you wish to send the next periodic SMS. The interval for these values may be set between 0 and 365.

- **Update time**: Select this icon to get local date and time from the PC.
Voice Message

This page can be used to record and replay the voice messages: refer to the “Voice Dialer” page for massage association to the events. To open the voice message archive, click the icon to the left of the RECORD button, on the right-hand side of the field “WAV File#1”. 

Note: The Communicator only supports WAVE audio files (.WAV), with a maximum duration of 16 seconds and with the following specifications: PCM, 8000 Hz, 8 bit, Mono, non-compressed. Prerecorded files fulfilling the abovementioned requirements may be used.

- PLAY button - Press to listen to the voice message again.
- RECORD button - Press to start recording a new voice message.
- STOP button - Press to stop replaying or recording a voice message.
- GET button - Press to load the recorded voice message.
- SET button - Press to send the recorded voice message to the Communicator.
- ERASE button - Press this button to erase the voice message on the Alarm Communicator. When recording a message, a progress bar indicates (in real time) the time elapsed.

Local Voice Message Recording

Note: You can connect ONLY ONE telephone to the [LI] terminals for proper working of the Local Voice Message Recording.

To record a voice message from a touchtone telephone connected to the [LI] terminals, enable the Local Service Mode in the Voice Dialer section and proceed as follows:

1. Press the button;
2. Press the buttons in sequence to enter record mode;
3. Enter the number of the message you wish to record (between and );
4. After the beep, record your voice message (the maximum duration of the message is 16 seconds).
5. Press the button to confirm message recording (or press the button again if you wish to stop recording the message before the full amount of time has elapsed); you will hear a boop tone.
   At this moment, any previous recordings for this message will be deleted;
6. If you need to record any other messages, repeat the procedure described in step 1.

Local Voice Message Replaying

Note: You can connect ONLY ONE telephone to the [LI] terminals for proper working of the Local Voice Message Replaying.

To replay a voice message from a touchtone telephone connected to the [LI] terminals, enable the Local Service Mode in the Voice Dialer section and proceed as follows:

1. Press the button;
2. Press the buttons in sequence to enter replay mode;
3. Enter the number of the message you wish to replay (between and );
4. After the beep, the message will be replayed, followed by a confirmation boop tone (press the key to stop the message playing);
5. If you need to replay any other messages, repeat the procedure described in step 1.
Optional Tamper Programming

Through the connection (see section *Connecting the device-* Auxiliary connections) of MAXIASNC tamper switch (optional) you can detect the Communicator cover opens. To send a SMS and/or voice message to one or more telephone numbers when the Communicator cover is removed, perform the following setup, by means of the VGSM-120 Console.

1. In the **Phonebook** page, enter the telephone numbers for the tamper message.

2. In the **I/O** page, set the T3 terminal as Input (Type column) with NO (Normally Open) standby status (Polarity column): the standby status of the tamper switch is Normally Closed.

3. In the **SMS dialer** and/or **Voice dialer** page set, for the **Input 3 Event**, the SMS and/or the Voice message, and the required telephone numbers.
NOTES
This product uses the FreeRTOS.org real time kernel. The FreeRTOS.org source code can be obtained by visiting http://www.FreeRTOS.org

FreeRTOS LICENSING:
“The FreeRTOS source code is licensed by the GNU General Public License (GPL) with an exception. The full text of the GPL is available here: http://www.freertos.org/license.txt. The text of the exception is available on FreeRTOS official website: http://www.FreeRTOS.org - License and Warranty Page

The exceptions permits the source code of applications that use FreeRTOS soley through the API published on this WEB site to remain closed source, thus permitting the use of FreeRTOS in commercial applications without necessitating that the whole application be open sourced. The exception should only be used if you wish to combine FreeRTOS with a proprietary product and you comply with the terms stated in the exception itself.”